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Quick Reference Guide for Screen�ow

1) The Main Menu: contains commands for working with Screenflow including how you view your user
interface. In the File dropdown menu you can publish your project straight to various platforms or export
it in a format ready for sharing. (Screenflow converts your project to be viewed outside of the Screenflow
format.)

2) The Canvas:  Previews whatever media falls directly beneath the scrubber in the timeline below.
(That’s the red vertical line with a handle.)

3) The Timeline: Shows whatever media you have placed inside your project from your Media library.
It is divided into stacked tracks which play simultaneously  as the scrubber passes over them, read from
top to bottom. In the image above there is a white cut-out on top but you can see the red animation
through the cut-out section and the audio track on the bottom will play no matter what you have above
it.

4) The Properties Window:  Each of the icons at the top of the window opens a new tab containing
editing options from which you can add text or add actions that transition your selected clip from one
state to another. There is also a tab containing your Media Library where you store imported media in its
original state and drag copies of it into the timeline as you need them. Editing a version of the media in
the timeline does not a�ect the original item in the library.
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The Canvas Area

 Directly below the Canvas you can click on the canvas control icon to bring up the canvas
properties where you can adjust your canvas size and background color.
 Using the playback controls you can play, jump to the beginning and jump to the end of your
project.
 There is a time code display showing the location of the scrubber in the timeline.

1. Whatever media is beneath your scrubber in the timeline
will display in the canvas area. Select a clip in the timeline
to edit it on the canvas.

2. Use the center handle to rotate your media.
3. Grab any resize handles and move them inwards or

outwards to adjust the size of your media.
4. Press and hold the Control key on your keyboard until you

see square resize handles instead of round ones and drag
any resize handle inward to crop your media.
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The Timeline Displays
 In the timeline area you will find a time scale at the top measured in seconds.
 You can click on the up/down arrows inside the track controllers on the le� to adjust the depth of
each track and click and hold on the position icon to drag a track up or down in the timeline
hirarchy.
 Use the timeline magnification slider at the bottom le� to zoom in and out on the timeline.
 Open the thumbnail display control to choose how your thumbnails are displayed within your
media clips and whether you want to see the wave form for an audio track.
 Snapping on sets your media to snap to guides or other media on your canvas and your clips to
snap to each other in your timeline. Most of the time this is convenient for accuracy but for those
times when it gets in the way, use the snapping toggle to toggle it o� and on again.

Working with Clips
 Click and drag a clip to move it anywhere you want on the
timeline.
 Grab either end of a clip and drag it inward to trim it.
 On a previously-trimmed clip, you can pull either edge out
from the clip to restore trimmed media.
 Right click and choose Add Freeze Frame to extend it.
 To close the gap between two clips click on the space between
them to bring up the blue highlight and hit Delete.
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To close a gap between multiple stacked clips

Place your scrubber at the
beginning of the gap you want
to close and hit the I key to
mark an in point.

Place your scrubber at the end
of the gap you want to close
and hit the O key to mark an
out point. (If either of your
points overlap media it will be
trimmed) Hit Command +
Backspace to close the gap.

If you have marked in and out points and you change your mind hit Option + Z to remove the blue
highlight.

If you only want to export a section of your project, you can also mark in and out points and go to the
Main menu and select  File > Export Selected Range.

Other Scrubber Operations
 Grab the top of the scrubber to move it along the
timeline. It will preview your media in the canvas as
you move it. Hit the arrow back and arrow forwards
keys to move in small increments.
 Click on a point inside the time scale to skip the
scrubber directly to that point.

 To split a stack of clips simultaneously place the
scrubber where you want the split to occur, grab it by
the handle at the bottom and move it to the right.
 To close a gap without disturbing the positions of
clips on the right, place your scrubber directly before
them, grab its handle and pull all media to the le�.
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To add Transitions to the beginning, the end or between clips.

1. Right click on the clip and choose between
Starting Transition, Ending Transition or Starting
and Ending Transition from the dropdown menu.
Transition boxes will automatically be added.

2. To add a transition between clips, hold down on
one clip and push it into another to create a
transition box.

3. Expand or contract the duration of a transition by
moving the thin vertical line separating the
transition from the main part of the clip.

2. Or double click inside the transition box to bring up the Transition
Inspector where you can choose a di�erent transition. Some
transitions include editable properties on the right.

1. Hover your cursor over the transition box till you see a gear icon.
Open it to reveal options to  Open Transition Inspector, Remove 
Transition or Choose a Di�erent Transition from the list.
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To adjust the speed of a clip or play it in reverse

Adding Actions right inside your media to make it transition from one state to
another

6. Adjust the settings below the + Action button to reflect what you want to happen once the action has
played. (In this example I want the music to fade out so I would set it to 0%. As the scrubber moves from
the beginning of the action to the end it will fade from 48% to 0% volume.)

You can drag the end of the action box to increase or decrease the duration of the transition.

Double click inside the clip or right click
on a clip and choose Show Clip Inspector
from the dropdown menu.

1. Place your scrubber where you want
the action to begin

2. In the Properties Window, select the
tab containing the properties you wish
to transition. (In this example, the
Audio  tab.)

3. Hit the + Action button which places an
action box inside your clip. (In this
example, the green Audio box)

4. Adjust the settings below the + Action
button to reflect the state you want to
start with. (In this example I want the
volume to start at 48%)

5. Move your scrubber to the end of the
action box. 
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Adding Annotations or Text to your project

Adding Video Actions to your clips.

The Annotations and Text tabs are
slightly di�erent from the Action tabs.
Here you click on the + button which
places an annotation clip or text clip in
your timeline independently of your
existing clips.

Once you have a text or annotation clip
in your timeline you can select it and
add actions to it in the same way you
add actions to your other media like
images or video clips.

To make an item transition from invisible to full size on the screen

1. Place media on your canvas where you want it to appear.
2. Select it in the timeline.
3. Open the Video tab. Set the scale to 0% and then click on the + Action Button.
4. Your media will no longer show on the canvas.
5. Move your scrubber to the end of the action.
6. In the  Video tab, set the scale to 100% (or a di�erent value as needed)
7. Your media will now appear on the canvas at the scale you chose.
8. Drag your video action box in or out to adjust the length of time you want your transaction to take.
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To make media rotate on the screen.

1. Select the media in your timeline. In this case I want the mask to rotate revealing di�erent colors
from the color wheel below it.

2. Place your media exactly as you want it in the starting position.
3. In the Video Actions tab hit the + Action button.
4. Your scrubber will automatically jump to the end of the transition box in the timeline.
5. You could pull the black dot around in the rotation button. If you want to rotate to an exact point

or in a particular direction, place a value in the Z Rotation box. A positive value will rotate you
media anticlockwise and if you place a - symbol before your value your media will rotate
clockwise. 

6. You can also set your rotation manually by moving the handle around on your canvas.
7. Lastly adjust the action box to set the duration of your rotation.

You can also tilt your media one way or another by entering your values in the X and Y value boxes or
moving the black dot around in the  X and Y rotation buttons.

To move  media, text or annotations around on your screen or fade them in and out.

All video actions work by starting with your media in the
position you want it, on or o� the screen. Then adding a video
action and moving your media to a new position on or o� the
screen. Then you adjust the length of the video action in your
timeline.

To fade media, text or an annotation in, select it in the timeline,
set the opacity to 0, add a Video Action, set the opacity to
100%. Adjust the length of the action in your timeline.
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The Chromakey filter is also part of the Video tab.

Use filters to create backgrounds  that blend in with your existing color choices.

1. If you want to have a di�erent
background showing behind
your media,

2. film your talking heads video in
front of a green screen.

3. In your timeline, place the
recorded video above a video
or an image you want to see
behind it in the background.
Select the recorded video

4. Open the Video tab.
5. Scroll down to Video Filters.
6. Hit the + button and choose

Chromakey from the filter
menu. You will still have to set
the color in the chromakey
settings to green to make the
green transparent.

1. Find a free image online that
roughly matches your color
scheme. (Pixabay.com)

2. Open the Video tab.
3. Scroll down to Video Filters.
4. Click on the + button and

choose Blur > Gaussian Blur.
Then click on Add.

5. Adjust the Radius slider until
your image is completely
blurred.

6. You may have to enlarge the
image beyond the parameter of
the canvas as the edges will be
semi transparent.
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The Audio tab

There is only one tab where you can edit audio
properties so it is easy to find. Don't forget that you can
add actions to your audio to fade in and out.

The Video Motion E�ects tab
Apply motion animated e�ects to your clips. You have three e�ects to choose from; Spring, Gravity and
Pulse. Each has a variety of settings to choose from to create professional looking animations.

I can't do the animations justice here with an image but you can get your elements to move in to
di�erent positions, bounce around the screen, drop at di�erent speeds or pulse in and out.
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Add e�ects to the mouse or keyboard shortcut gestures you made whilst
screencasting in the Screen Recording tab. 

This will not work on images or imported video clips because there will be no gestures to
follow so the options will be greyed out if you try.

Decide whether you want to
show or hide your mouse
pointer.

Leave your pointer at the
default size or zoom in to make
it more noticeable.

You can select a di�erent shape
for your pointer or you can
choose an image. In this case I
have used a blue arrow. While
selecting an image in your
finder window, open the
options button and set your
cursor  hotspot  position.

You can add sound to your
clicks.

You can show all keystrokes or
select only the modifier keys
used. In this example I have
used Command + V to past a
name into the Name field of this
signup form. Set your size
preferences and hit the (F)
symbol to bring up a font
selection menu.

Choose a Radar click e�ect or
Invert the colors of your pointer
every time you click.
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Applying Callout Properties

Callout properties highlight specific elements of your screen. Mouse Cursor Callouts and Foreground
Window callouts can only be added to screencasts. Freehand Callouts can be applied to images as well.
For all callouts you need to select the media in your timeline and hit the Add button in the Callouts tab.
Once you have set your preferences you can stretch the callout in the timeline to match the length of the
action you are calling out.

Starting with the Mouse Cursor Callout:

Your mouse will be surrounded by a small circle which will follow it around the screen. 

1. By default the background opacity will be set to 70%.
2. Reduce the opacity if you still want to see what's going on on your screen. I have reduced the

opacity of image 2 to 40%.

There are two Blur options. 

1. The slider will blur whatever is inside your cursor circle.
2. The Blur Background button will blur the background of your whole screen.
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1. Zoom Up will simply zoom in on your cursor circle as it is. 
2. If you want to enlarge the actual cursor circle you have to add a border to it by sliding the Border

Slider to the right.
3. You can then go back to Zoom Up and zoom in on the enlarged curser circle.
4. Outline adds an outline to your cursor circle. You can change it's color by clicking on the color well.

(The blue box)

Build the action in and out using the build settings so that it does not jump on and o� the screen.

Foreground Window Callout

If you want to highlight a foreground window in your
screencast, choosing the Foreground Window highlight
will automatically snap to the parameters of your
foreground window. You can then adjust the zoom slider,
the background opacity settings etc. as you can with a
Mouse Cursor callout.
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Freehand Callout

Select the clip in your timeline that you want to add a Freehand Callout to. In this example I have
selected an image which has text above it in the hirarchy. Add an action in the Callouts Tab and choose
Freehand. A popup menu will appear beside the Properties Window:

In some instances a Mouse Cursor
Callout is not the best solution
because it is round and it follows
your mouse movements on the
screen. Freehand Callouts do not
follow your mouse and you can
choose round, square or a
freehand drawing. In this example
I want the video to zoom in and
play without my cursor showing.

1. Choose the freehand cursor if
you want to block out a section
of your image or draw a shape
over it. You can adjust your
cursor size using the slider
below.

2. Select the square if you want to
add an action to part of an
image or screencast. This is
what you use to create the zoom
e�ect in the video example I
showcased above,   to block out
sensitive data like passwords
while screencasting a lesson
and to blur the media below
your text to make the text stand
out.

Send the opacity of the rest of
the media down to zero and
adjust the blur or the callout
section to suit your needs. 
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Touch Callouts ~ to show what finger movements you used when recording on an
iOS device.

Although Screenflow can track
wherever you clicked with your
mouse in a screencast on a
computer, it cannot track where
you touched on an iOS device so
you have to add visual clues
manually.

Touch callouts mimic finger
gestures like press, pinch or
swipe.

Just like any action or callout, you
select the media in the timeline.
Line your scrubber up to the exact
point you want the action to start
and add an action in the Touch
Callout tab. Set your preferences
for size, color etc. Set an end state
and your callout will   animate
your finger movements. In this
example I am zooming in.

Adding Annotations
No need to select anything in the timeline. Just place your scrubber where you want to add an
Annotation and hit the + button in the Annotations tab. Choose an annotation.

1. Draw your annotation on your
canvas and adjust it's color,
opacity, thickness etc. while
you are still  in settings mode.

2. To move your annotation
around the screen or add
actions to it, select it in your
timeline. If you need to go back
to editing   its settings,   double
click on it on the canvas to take
you back to settings mode.
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Adding Text

No need to select anything in the timeline. Just place your scrubber where you want to add your text
and hit the + button in the Text tab. 

A text box will appear in your
canvas area with the place
holder text already highlighted

Start typing in your own text.
Don't worry if it runs o� the
canvas.

Select the text clip in your
timeline to bring up the resize
handles and resize your text
box.

Click back inside the text box on
your canvas to go back into
settings mode. Select the text.
Choose a di�erent font, font size
alignment etc. Toggle the Fill
button on or o� to control the
text background. You can even
fill it with an image if you want.
Give your text an outline and

adjust the kerning. (Kerning is the space between characters)

In Screenflow 8 and above you can add Animations to your text by placing a check inside the Build in
Animation box. Open the Type dropdown menu to see a list of available animations.
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By now you should be well on your way to producing great videos, this quick user guide just scratches
the surface of all the amazing editing tricks you can learn to use in Screenflow. If you want to learn more
and see everything demonstrated in a series of videos I have a full Screenflow course:

Learn Screenflow for Mac

For only  you get a comprehensive course
that covers how to:

 How to record a screencast from your computer,
your smartphone or tablet.
 Apply transitions and video actions to it.
 Add callouts to focus attention to specific
elements on your screen.
 Add text and annotations like arrows or boxes.
 Add video motion e�ects to your elements. (New
from Screenflow 6 onwards)
 Add touch callouts to show finger movements on a
device.
 Create style presets for actions that you want to
repeat frequently. (New from Screenflow 8 onwards)
 Create your own templates with your media preloaded. (New from Screenflow 8 onwards)
 And add closed captions.
 As well as your export and publish options.

If you enroll now you get  FREE added design and communication modules:

 Bonus 1 - How to find a suitable topic to teach
 Bonus 2 - Design and communication
 Bonus 3 - Outlining and scripting a course
 Bonus 4 - Making a persuasive promotional video so that you can sell your own courses.

US$39
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